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1
 Working with Trouble Manager
These topics are in this section:

 Introduction

 Work Items and Trouble Tickets

 The Workflow

 Trouble Manager Tasks

 Logs and Reports

 Trouble Manager Tools
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Introduction
Using ACTIVIEW Trouble Manager, you can track and monitor 
customer-reported and network trouble reports from beginning to end. 

Trouble Manager lets you:

 Document the work that is being performed on reported customer and 
network troubles.

 Create a historical database of troubles and their resolutions. You can then 
refer to this database when you attempt to solve future troubles with 
similar symptoms.

Opening Trouble Manager
To open Trouble Manager:

1 Open the Communications Software Launcher with a browser. You can 
open Trouble Manager from Communications Software Launcher (CSL), 
Secure Access Gateway for Enterprises (SAGE), or another launch 
mechanism specific to your operations. Both CSL and SAGE use a network 
browser, such as Netscape Navigator, and an Internet Protocol (IP) 
address.

2 Click the Trouble Manager icon.

If you need help opening the Communications Software Launcher or Trouble 
Manager, follow your company’s procedures. Typically this means contacting a 
help desk or an ACTIVIEW administrator.
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Figure 1.1 —  The Communications Software Launcher (CSL) window

Trouble Manager icon
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Work Items and Trouble Tickets
Work items are used to identify and report data on troubles that may be affecting 
service. These work items are the key to managing and tracking the trouble 
resolution process. 

Trouble Manager tracks reported troubles by creating one work item for each 
trouble ticket. These work items are used to manage the overall trouble resolution 
process, which follows a work flow that is defined by the administrator. Your 
Worklist contains work items that were assigned to your User ID by the 
administrator. 

Each row on the Worklist represents a work item that needs to be completed. One 
task may appear on multiple Worklists at the same or at different times. When 
and where the task appears depends on the task model that your company is using 
and where the task occurs in the workflow.

Trouble tickets
There are two types of trouble tickets:

 Customer Trouble Tickets (CTTs) – When a subscriber or customer 
reports a trouble, a CTT is generated. Usually this type of trouble affects 
only one customer, but multiple customers may report problems with the 
same root cause.

 Network Trouble Ticket (NTTs) – When a network monitoring system or 
network technician identifies the trouble, an NTT is generated. This type 
of trouble affects a portion of the network and may affect many customers.

There are two ways that these trouble tickets can be created: 

 Manually – When you enter information into Trouble Manager in response 
to a telephone call or written data source.

 Automatically – When information is entered into Trouble Manager from 
an upstream trouble-reporting system and a trouble ticket is automatically 
generated.

For example, when Trouble Manager receives switch alarms from a 
Network Fault Manager (NFM), an NTT is automatically generated. When 
this happens, the Originating System for the NTT is identified as NFM on 
the Worklist window.
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The Workflow
When a trouble ticket is created in Trouble Manager, the trouble ticket is assigned 
to a particular workflow. This workflow determines what trouble resolution tasks 
are performed on the trouble ticket and by whom those tasks are performed. These 
tasks are combined to create an end-to-end workflow based on a particular 
Task Model. When the last task in the workflow is completed, the trouble should 
be resolved. 

Depending on the type of trouble that is reported, Trouble Manager uses the Task 
Model and associated workflow that has been placed in the system to:

 Process a particular type of trouble report

 Track the trouble through resolution

 Processes each task in the Task Model until tasks are completed and the 
trouble is resolved

As the Trouble Ticket proceeds through a workflow, Trouble Manager performs 
the following administrative activities:

 Manages corresponding transactions

 Monitors the outcome of each transaction

 Directs the workflow to the next scheduled step

Task Models
Workflows are determine by Task Models, which can be different for every 
company. Company administrations can use a separate application called 
Workflow Editor to modify an existing workflow and create new workflows. 
Trouble Manager can have multiple workflows.

When creating a Task Model, an administrator:

 Sets up the steps of a workflow

 Decides which Worklist the work items associated with a particular trouble 
ticket should appear on

 Determines when a work item should appears on a Worklist
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Figure 1.2 —  A typical high level workflow for processing a trouble report.

Receive report of trouble

Create new trouble ticket

System automatically distributes
trouble tickets to user worklists

Trouble is resolved

Update work item
with resolution information

Complete tasks on worklists

Trouble ticket is closed
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Tracking due dates and times
Based on the workflow assigned to your trouble tickets, a set of milestones is 
created for the workflow tasks. Trouble Manager determines the due dates and 
times for a trouble ticket by adding up the amount of time it should take you to 
complete each task for the trouble ticket.

Trouble Manager automatically tracks these milestones, and when a milestone is 
completed, the date and time when task is completed is associated with the trouble 
ticket.

If a work item milestone is in jeopardy of being missed or has been missed, 
Trouble Manager changes the color of the work item on the Worklist from black 
to red. When a work item on your Worklist changes to red, you need to take 
immediate action on this item so that the due date will not be missed.

However, if a milestone is missed or is in jeopardy of being missed, you may have 
to manually recalculate the due date and time based on how long it will take to 
complete the remaining tasks. 

Workflow tasks
The tasks contained in a workflow are performed either manually or 
automatically:

 Manual Tasks – Certain tasks, such as analyzing the trouble, must be 
performed manually. The information associated with these tasks are 
manually entered into Trouble Manager.

 Automatic Tasks – Certain tasks are performed internally by ACTIVIEW 
such as setting the initial due date and time for the trouble to be resolved. 
Other tasks may require data input from other systems that interface with 
Trouble Manager. After a task is completed, information about the 
outcome is stored by Trouble Manager.
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Workflow example
The following table shows a generic example of how a workflow might be 
processed by Trouble Manager. 

Step Task Task Type Explanation Status

1 Start Process Automatic Begins the trouble resolution 
and monitoring process

Open

2 Create Trouble 
Ticket

Manual or 
automatic

Associates the trouble report 
with Trouble Manager

Ticket Open

3 Query for related 
circuits

Manual or 
automatic

Identifies circuits possibly 
related to the trouble

Pending 
Analysis

4 Analysis Manual Expert analysis of the trouble 
by network and/or support 
personnel

Pending 
Analysis

5 Block Cancel Automatic Automated step disallows 
cancelling the trouble ticket

Assigned

6 Dispatch Personnel Manual Assignment of central office 
and field technician to trouble

Pending 
Dispatch

7 Travel to work site Manual Personnel proceed to 
appropriate locations

Dispatched

8 Resolve Trouble Manual Testing and analysis at 
appropriate locations

At Source 
of Trouble

9 Set Status to 
Complete

Manual Complete task on Worklist of 
technician resolving trouble

Pending 
Review

10 Activate Children Automatic Automated step activates any 
child tickets

Pending 
Notification

11 Propagate 
Completion data

Automatic Advances ticket along the 
workflow

Pending 
Verification

12 Close Trouble 
Ticket

Manual Manual step to close the 
Trouble Ticket

Pending 
Completion

13 Process Complete Automatic Ends the workflow for this 
item

Closed
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Trouble Manager Tasks
Here are some important activities you can perform in Trouble Manager:

 Create a CTT or NTT – lets you add a new trouble ticket into the database.

 Pick up a work item - lets you pick up a work item before you can move 
a work item to the next step in the workflow. When a work item is picked 
up, other users can view it, but they cannot pick it up.

 Drop a work item - lets you release a picked up work item so that other 
users can pick it up.

 Find a work item - lets you search for work item on the Worklist or in the 
Trouble Manager system.

 Retrieve and update an existing CTT or NTT - lets you update an existing 
trouble ticket with new information.

 Link and unlink CTTs to and from NTTs - lets you associate or 
disassociate a CTT with an NTT.

 Complete a task - lets you end a task for the work item when that task is 
finished.

 Cancel a work item - lets you cancel any future work on a trouble ticket.
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Logs and Reports
Trouble Manager maintains a set of logs and reports related to the trouble tickets 
that provide historical data related to the workflow process on the trouble. These 
reports and logs are the:

 Tasks and Milestones Report – This report shows the time frame and 
completion information for all active and completed tasks for a trouble 
ticket. It also shows the future milestones and estimated completion.

 Due Date & Time Log – This log records the resolution dates associated 
with the trouble ticket. This log is updated each time the completion date 
is changed.

 Trouble Ticket Log – This log records all activities for a trouble ticket. This 
log is updated as comments are entered into the ticket or as tasks are 
completed for the trouble ticket.

 Test Log – This log records the testing that has been performed on the 
trouble associated with a particular ticket. New test data can also be added 
to this log when future tests are run.
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Trouble Manager Tools
Here are some Trouble Manager tools that you want to be familiar with:

 Troubleshooting support tools – Although all of the trouble tracking and 
monitoring features associated with Trouble Manager directly or indirectly 
support trouble resolution, several are more closely related to 
troubleshooting support.

 WORD Access – Use the Work Order Record Details (WORD) Access 
feature to identify circuit information associated with a trouble ticket. The 
circuit information can then be used to help determine a plan for testing 
circuits. You can only use the WORD Access feature if there is an external 
system with circuit information that Trouble Manager can access.

 Run Tests – Use the Run Tests feature to run specific tests that have been 
predefined by your company. You can enter the test results into the Test 
Log so that you can look at them again, use the results to determine what 
the issue is, or use the results to promote the eventual resolution of the 
problem. Each trouble ticket has its own Test Log.

 Network Cut Through – Use the Network Cut Through feature to access 
a network element that may contain data or test utilities that can help you 
resolve the trouble.

 Wireless Reach Through – Use the Wireless Reach Through feature to 
access Home Location Register (HLR) data associated with Wireless 
services.

 Wireline Reach Through – Use the Wireline Reach Through feature to 
access switching elements that may contain data or provide access to test 
utilities that can help you resolve the trouble.
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2
 Using Icons, 
Buttons, and Fields
These topics are in this section:

 Icons

 Buttons

 Fields
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Icons
Icons are graphical representations of options that you find on a menu. When you 
click an icon, you are performing the same action as selecting a menu option. 
However, you only have to click icons once and you have to select a menu option 
from a menu, which takes a little more time. These icons are in Trouble Manager:

Click this icon... To do this... Notes

Cancel

Delete a work item from the Worklist and cease 
all processing of the troub le ticket. Most task 
models will have the cancelled work item 
removed from the Worklist.

This icon is the same as Cancel in the 
Worklist Tickets menu.

Create a New 
CTT

Have the system “create” a  new Customer 
Trouble Ticket (CTT) based on information you 
entered in the New CTT wind ow. 

“Create” means to finish or complete the 
creation of a the trouble ticket.

Create a New 
NTT

Have the system “create” a new Network Trouble 
Ticket (NTT) based on information you entered 
in the New NTT wind ow. 

“Create” means to finish or complete the 
creation of a the trouble ticket.

Create and 
Complete (a 

CTT)

Enter a new CTT into the system and closes it. 
The closed CTT is removed from the Worklist 
and the data is saved in the system. 

This icon is the sa me as Create & 
Complete option in the Work Item 
menu on a CTT window. 
Use this option when you need to 
record information about a resolved 
customer or network problem. This 
information documents your work 
and adds the information to the 
ACTIVIEW history database.

Create and 
Complete (a 

NTT)

Enter a new NTT into the system and closes it. 
The closed CTT is removed from the Worklist 
and data is saved in the system. 

This icon is the sa me as Create & 
Complete option in the Work Item 
menu on a NTT window. 
Use this option when you need to 
record information about a resolved 
customer or network problem. This 
information documents your work 
and adds the information to the 
ACTIVIEW history database.
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Complete Task

Complete a task and let the work item go to the 
next task in the task model.

This icon is the same as the Complete 
Task option in the Worklist Tickets 
menu. 
Use this option when you need to 
record information about a resolved 
customer or network problem. This 
information documents your work 
and adds the information to the 
ACTIVIEW history database.

Drop (a task)

Release ownership of a work item that you have 
previously picked up. 

This icon is the same as the Drop option 
in the Worklist Tickets menu.

Due Date and 
Time Log

View the Due Date & Time Log, which records 
the initial and modified due dates and times.for 
a trouble ticket. 

This icon is the same as the Due Date 
& Time option in the Log menu on a 
Trouble Ticket window.

Enter CTT

Open the Enter CTT window so that you can 
review a list of po tentially related CTTs, if 
available, or open a New CTT window. Use this 
option when new customer trouble is reported 
and you need to decide whether you should add 
the issue to an existing ticket or create a  new 
ticket. 

This icon is the sa me as Enter CTT 
option in the Worklist Tickets menu.

Enter NTT

Open the Enter NTT window so that you can 
review a list of po tentially related NTTs, if 
available, or open a New NTT window. Use this 
option when a new network trouble is reported 
and you need to decide whether you should add 
the issue to an existing ticket or create a  new 
ticket. 

This icon is the sa me as Enter NTT 
option in the Worklist Tickets menu.

Help

Open the help window to view help information. This icon is the same as ACTIVIEW 
Help Topics option in the Help menu. 

Link

Associate a CTT with a related NTT. This icon is the same as Link option in 
the Worklist Tickets menu.

Click this icon... To do this... Notes
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Open

Open an existing trouble ticket (either a CTT or 
NTT window) for a highlighted work item on the 
Worklist.

This icon is the same as the Open option 
in the Worklist Tickets menu.

Pickup (a work 
item)

Own an existing trouble ticket (work item) to 
let the trouble ticket advance to the next task in 
its task model.

This icon is the sa me as the Pickup 
option in the Worklist Tickets menu.

Print

Send a trouble ticket to a default system printer. This icon is the same as the Print option 
in the Work Item menu on a Retrieve 
Trouble Tickets window.

Save

Save updates that you made to a trouble ticket. This icon is the same as the Save option 
in the Work Item menu on a Retrieve 
Trouble Ticket window.

Test Log

View the Test Log for the trouble ticket. This icon is the sa me as the Test Log 
option in the Logs menu on a Trouble 
Ticket window.

Trouble Ticket 
Log

View the Trouble Ticket Log for the trouble ticket. This icon is the same as the Trouble 
Ticket Log option in the Logs menu on 
a Trouble Ticket window.

Unlink

Unlink a CTT from a NTT, or to unlink all CTTs 
from a NTT. 

This icon is the sa me as the Unlink 
option in the Worklist Tickets menu or 
the Unlink option in the Work Item 
menu in a Retrieved TT window. 
By default, a CTT typically disappears 
from the Worklist when it is linked to a
NTT. If you ne ed to unlink a CTT, you 
can find these linked CTTs using the 
Find Trouble Tickets option in the Find 
menu. After a NTT is resolved, you can 
link all related CTTs at once because 
resolving the NTT should resolve most 
if not all of the C TTs.

Click this icon... To do this... Notes
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Buttons
Buttons are used to execute actions on system windows. Buttons are found in 
many windows. The following buttons are representative of those commonly 
found in the user interface:

You can find more information about other buttons in Trouble Manager when you 
read about the windows in Trouble Manager.

Click this button... To do this...

Calculate Automatically calculate a due date and time for a trouble ticket and 
place it in the Due Date & Time field. 

Cancel Close the window without making any data changes or add any items 
to the Worklist.

Close Close the window.

Find Next Search for the next occurrence of the item you are searching for. 
You can continue to click this button until all occurrences are found.

Find Now Search for trouble tickets that match your search criteria and list 
them in the Worklist area. The number of trouble tickets displayed 
is determined by the value in the Get up to field.

Help Access the online help.

New Create a new record in the test log.

New Search Clear the search criteria fields in a window so that you can do a new 
search.

New CTT Create a new CTT.

New NTT Create a new NTT.

Get More Get the next set of tro uble tickets that match your search criteria. 
The number of trouble tickets displayed is determined by the value 
in the Get up to field.

OK Save the information you entered to the d atabase and close the 
window.

Re-calculate Re-calculate a new due date and time for a trouble ticket or override 
the current due date and time with data you specify.

Retrieve CTT List any open or closed CTTs associated with the Trouble ID.

Retrieve NTTs List any open or closed NTTs associated with the Trouble ID.
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Fields
Fields are used to display information or let information to be entered into the 
system. In Trouble Manager:

 Read-only fields are gray

 Updatable fields are white

 Mandatory fields have bold field names

 Some fields have drop-down menus that you select an option from a list 
of two or more options. A drop-down menu typically contains options that 
are found in a User Managed Table (UMT)

Note You can refer to the service provider’s published 
UMT values for the current release of Trouble 
Manager. Many service providers keep published 
UMT values on an intranet web site with o ther 
documents such as company specific job aids or 
detailed methods and procedures. Administrators 
may reference the ACTIVIEW UMT Administration 
Guide for more information about adding, changing, 
and deleting UMT entries.
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Types of fields
Trouble Manager has these types of fields:

 Check Box – Place a mark in the box by clicking it. This activates the field 
next to this check box. You can remove the mark by clicking the box again.

 Frame to Frame Selection Lists – Move a option to another frame by 
selecting the option, then clicking the arrow button that points in the 
direction you want the value.

 Drop-down Menu – Select the text name or the arrow at the right of the 
text box to display the list of options for this field, then select an option.

 Radio Buttons – Select a radio button by clicking it. You can only select 
one radio button in a group of radio buttons.

 Slide Bar Selection Lists – Select an item in a slide bar selection list by 
dragging the slide bar (up and down or left and right) to view the list of 
options, then selecting an option.

 Small View Text Area – Enter the appropriate information in the text box. 
Select the up and down arrows to view the text box two lines at a time.

 Text Entry – Enter the appropriate information in the text box next to the 
field name.



3
 Worklist Settings Window
This topic is in this section:

 About this Window

 Field Descriptions

 Related Tasks
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About this Window
The Trouble Manager Worklist Settings window lets you define the Worklist 
language and Worklist set for Trouble Manager.

The Worklist Settings window opens when you open Trouble Manager from the 
Communications Software Launcher (CSL), Secure Access Gateway for 
Enterprises (SAGE), or other launch mechanism window.

Figure 3.3 —  Trouble Manager Worklist Settings window 

Note This window is bypassed unless a service provider 
requires multiple languages, or your job requires 
multiple Worklist sets. Worklist sets are created by  
the ACTIVIEW administrator and establish the 
functionality for each session of Trouble Manager.
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Field Descriptions
These fields appear on this window: 

Field Name Description

Worklist Language Your preferred language, e.g., English, French, or German.

Worklist Set Lets you select a Worklist Set from a list of Worklist preferences 
that are predetermined by the ACT IVIEW administrator. The 
administrator not only determines which Worklist Sets are 
available to the user but determi nes the characteristics of each 
Worklist Set.
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Related Tasks
 Chapter 44, Determine Worklist Settings
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	Opening Trouble Manager
	When to use
	Note
	Related information
	To start ACTIVIEW Trouble Manager from the CSL:
	1 From the launch mechanism window such as Communications Software Launcher (CSL), select the ACT...
	2 If applicable, go to “Determine Worklist Settings” on page 307.
	Determine Worklist Settings


	When to use

	Note
	Related information
	To define the Trouble Manager Worklist language and Worklist set.
	1 From the Communications Software Launcher (CSL) screen, select the ACTIVIEW Trouble Manager (TM...


	Note
	2 Select the preferred Trouble Manager Worklist Language and Worklist Set.
	3 Select the OK button. The Trouble Manager Worklist window is displayed.
	4 Select the Cancel button. Trouble Manager Worklist Settings window closes.
	Change Worklist Preferences
	When to use
	Related information
	To hide or display columns on a window:
	1 In the Worklist window, select Preferences from the Worklist menu. The Worklist Preferences win...
	2 Move items to the Display column by selecting the name of the item, then clicking the Display b...
	3 Move items to the Hide column by selecting the name of the item, then clicking the Hide button.
	4 Move an item up in the order by highlighting the item, then clicking the Move Up button.
	5 Move an item down in the order by highlighting the item, then clicking the Move Down button.
	6 Click the Dates & Time Format tab.
	7 Select the Time from the Time Format list.
	8 Click OK. The preferences are saved.
	9 Restart Trouble Manager to see the new settings.
	Find the Trouble Ticket on the Worklist Window


	When to use
	Related information
	To find a trouble ticket on the Worklist window:
	1 On the Worklist window, select Find from the Find menu. The Find (on this Worklist) window is d...
	2 In the Where field, select which column of the Worklist window to search.
	3 In the Find What field, enter the information to be used in the search.
	4 Select details on how the search is to be performed.
	5 Select Find Next. The Worklist is searched, and the first trouble ticket that meets the search ...
	6 If you want to continue searching using the same search criteria, click on the Find Next button.
	Find Trouble Tickets


	When to use
	Related information
	To find a trouble ticket:
	1 In the Worklist window, select Find Trouble Tickets from the Find menu. The Find Trouble Ticket...
	2 Search for Trouble Tickets by selecting a tab and entering your search parameters.

	Note
	3 Enter the maximum number of Trouble Tickets that you want to be listed in the text field above ...
	4 Click Find Now. The Trouble Tickets that contain the information that you are searching for are...
	5 To find more work items based on the current search, click Get More. The system lists another s...
	6 If you want to sort the work item list, click Sort Table. The Sort Table window appears.
	7 If you want to initiate a New Search, click New Search. All text fields are cleared. Go to Step 2.
	8 To close the Find Trouble Ticket window, click Close. The Find Trouble Ticket window is closed.
	Sort Table

	When to use
	Related information
	To sort the Worklist or find a trouble ticket table by up to three columns:
	1 Select Sort Table Menu from the Worklist menu. The Sort Table window is displayed.
	2 Select a column from the Primary Sort drop-down menu.
	3 Select the Ascending or Descending radio button.
	4 If you want to sort a second column, select the column from the Secondary Sort drop-down menu.
	5 Select the Ascending or Descending radio button.
	6 If you want to sort a third column, select the column from the Tertiary Sort drop-down menu.
	7 Select the Ascending or Descending radio button.
	8 Click OK. The Sort Table window closes and the tables are sorted.
	View a User History


	When to use
	Related information
	To view the tasks that a user has worked on:
	1 Select the User History option from the Search menu. The User History window opens.
	2 Select a User ID from the drop-down menu.
	3 Select the number of days (1 to 7) from the drop-down menu.
	4 Click Search. The system lists all trouble tickets for the user.
	5 Print out the User History.
	6 Click Close. The User History window is closed.
	Create a Trouble Ticket

	When to use
	Related information
	To start a trouble ticket for a reported network or customer trouble.
	1 In the Worklist window, select Enter (New) CTT or Enter (New) NTT from the Tickets menu. The En...
	2 Enter an ID in the Trouble ID field. A Trouble ID is service identifier such as a calling card ...
	3 Click Retrieve CTTs or Retrieve NTTs. The system searches for open or closed trouble tickets li...
	4 If a related open trouble ticket exists, open the trouble ticket, and make sure that the troubl...
	5 Enter the new information in the text fields, as applicable. Although the a Trouble ID field is...
	6 Click OK. A new trouble ticket (CTT or NTT) is created.
	7 After you create a trouble ticket, you can:
	» Perform a Network Cut Through. See Use Network Cut Through.
	» Conduct a Location ID search. See Search for a Location ID.
	» Calculate the Due Date & Time. See Recalculate Due Date and Time.
	Search for a Location ID



	When to use
	Related information
	To find a Location ID:
	1 If the NTT window, select Location ID Search from the Search menu. The Location ID Search windo...
	2 Select a State, Province, or Region from the first column.
	3 Select a City or Town from the second column
	4 Select a Street Address from the third column.
	5 Select a Location ID from the forth column.
	6 Click OK. The Location ID Search window closes and the Location ID appears in the Location ID t...
	Use Network Cut Through


	When to use
	Related information
	To use Network Cut Through:
	1 If you are on the Worklist window, New NTT window, or Retrieve window, select Network Cut Throu...
	2 If the Equipment ID is not listed, enter it.
	3 Click OK. This event launches a telnet session window to NFM.
	4 Review the Network Cut Through data.
	5 Click Cancel. The Network Cut Through window is closed.
	Search for Customer Records



	When to use
	Related information
	To search a Customer Record Database:
	1 If you are in the Worklist window, New CTT window, or Retrieve CTT window, select Customer Reco...
	2 Select one of these radio buttons:
	» Customer TN
	» Account Number
	» Customer ID
	» Circuit ID
	» Company Name
	» Resident’s Name



	Note
	3 Enter the appropriate information in the corresponding text field.
	4 Click Get Record. A window opens with a list of customer records that contain the information t...
	5 If you want to perform a new search, click New Search. All text fields are cleared.
	6 To close the Customer Record Search window, click Close. The window closes.
	Link a New CTT to an Impacting NTT
	When to use
	Related information
	To link a new CTT to an NTT:
	1 In the CTT window, select Impacting NTT from the Search Menu. The Impacting NTTs window opens w...
	2 If the CTT is related to any NTTs on the list, select the NTT from the list.
	3 Click Set as Parent. The CTT is linked to the impacting NTT, and work on the CTT is suspended u...


	Note
	4 Click Cancel. The Impacting NTT window closes.
	Use Wireless Reach Through

	When to use
	Related information
	To see the network element details associated with a wireless ticket:
	1 From the New CTT, Retrieved CTT, or Worklist window, select Wireless Reach Through from the Vie...
	2 Enter the required parameters. You must have all of the values filled out to initiate Reach Thr...
	3 Click Reach Through. The system accesses a Home Location Register (HLR) to verify that the wire...
	4 Click Close. The Wireless Reach Through window is closed.
	Use Wireline Reach Through



	When to use
	Related information
	To see the network element details associated with a wireline ticket:
	1 From the New CTT window or Worklist window, select Wireline Reach Through from the View menu.
	2 Enter the required parameters. You must have all of the values filled out to initiate Reach Thr...
	3 Click Reach Through. The system accesses a Home Location Register (HLR) to verify that the wire...
	4 Click Close. The Wireline Reach Through window is closed.
	Link a CTT to an NTT

	When to use
	Related information
	To link the selected CTT (child work item) to an NTT (parent work item):
	1 From the Worklist window, select the work item (CTT) and select Link from the Tickets menu. The...
	2 Enter the Work Item ID for the NTT (parent) and any related comments.
	3 Click OK. The CTT is linked to the NTT and work on the CTT is suspended until the NTT is resolv...


	Note
	4 Click OK. The TM-Link Succeeded window closes.
	Unlink a CTT from an NTT
	When to use
	Related information
	To unlink the selected CTT (child work item) from a linked NTT�(parent�work�item):
	1 From the retrieve CTT window, select Unlink from the Work Item menu. The Unlink Child window is...
	2 Enter comments, if needed.
	3 Click OK. The CTT is unlinked from the NTT.
	Unlink All CTTs from an NTT



	When to use
	Related information
	To unlink all linked CTTs (child work items) from the selected NTT (parent work item).
	1 From the Worklist window, select the NTT, then select Unlink from the Tickets menu. The Unlink ...
	2 Click OK. A message window opens.
	3 Click OK. The Unlink Parent window closes and all linked CTTs are unlinked from the NTT.
	Open a Trouble Ticket

	When to use
	Related information
	To open a trouble ticket:
	1 From the Worklist window, double-click the trouble ticket. The trouble ticket window opens.
	2 Update any information, if necessary.
	3 Select Save from the Work Item menu. Any changes to the trouble ticket are saved.
	4 Select Close Work Item from the Work Item menu. The Retrieve NTT or Retrieve CTT window closes.
	Search for Related Circuits



	When to use
	Related information
	To view the circuits related to a specific customer name or ID:
	1 From the Worklist window, select Related Circuits List Search from the Search menu.
	2 If you want to view the related circuits for all customers, do not enter any text in the Custom...
	3 Click Close. The Related Circuits List Search window closes.
	View WORD Circuit Information

	When to use
	Related information
	To view network topology information (Dimension WORD information):
	1 From a CTT or NTT window, select WORD from the View menu. The Circuit information is shown usin...
	To view network topology information (Physical Resource Manager WORD information):

	1 From a CTT or NTT window, select WORD from the View menu. A WORD Access window opens.
	2 Enter the Circuit ID.
	3 Select the WORD Type.
	4 If you want to print the information, select the Print radio button, then enter the printer inf...
	5 Click OK. The WORD information is sent to the printer or appears online.
	To view network topology information (CircuitView information using View Manager).

	1 From a CTT or NTT window, select WORD from the View menu. A WORD Access window opens.
	2 Enter the Circuit ID.
	3 Enter the IP Address, if the field is available (optional).
	4 Click OK. The View Manager window opens.
	5 Use the View Manager facility to send the information to a printer or to view the circuit data ...
	Recalculate Due Date and Time



	When to use
	Related information
	To recalculate the due date and time for a trouble ticket:
	1 From the CTT or NTT window, click the Dates & Times tab.
	2 Click Re-Calculate. The Re-Calculate window opens.
	3 If you want the system to automatically re-calculate a new due date and time, click Re-Calculat...
	4 If you want to enter a new due date and time, select the Override check box, then enter the due...
	5 Click OK. The new Due Date and Time is saved.
	Retrieve SNPA Information



	When to use
	Related information
	To retrieve SNPA information:
	1 In the CTT window, select SNPA Data from the Search menu. The SNPA Data window opens.
	2 Enter the telephone number in the TN field.
	3 Click Retrieve SNPA Data.
	4 View the SNPA information. You will not be able to save the information.
	5 Click Close. The SNPA window closes.
	Run a Test

	When to use
	Related information
	To run a test.
	1 In the CTT or NTT (New or opened) window, select Run Test from the Work Item menu. The Run Test...
	2 Select a test from the Test Type drop-down menu.
	3 Click OK. A message window opens. You can view the results by opening the work item again and v...


	Note
	View the Trouble Ticket Log
	When to use
	Related information
	To view the Trouble Ticket (TT) log:
	1 From the CTT or NTT window, select Trouble Ticket Log from the Logs menu. The Trouble Ticket Lo...
	2 Click List User Comments Only. The Trouble Ticket Log window lists user comments.
	3 If you want to send a copy of the trouble ticket log to your default system printer, click Prin...
	4 If you want review the log information online, view the log information, then click Close. The ...
	View Due Date and Time Log


	When to use
	Related information
	To view the Due Date & Time Log for a Trouble Ticket:
	1 In the CTT or NTT window, select Due Date & Time Log from the Logs menu. The Due Date & Time Lo...
	2 View the information in the window.
	3 Click Close. The Due Date & Time Log window closes.
	View the Test Log


	When to use
	Related information
	To view the test log for an existing record:
	1 In the CTT or NTT window, select Test Log from the Logs menu. The Test Log window opens.
	2 Select the record in the table. The information about the record is shown in the Current Record...
	3 Click Close. The Test Log window is closed.
	To view a test log for a new record:

	1 In the CTT or NTT window, select Test Log from the Logs menu. The Test Log window opens.
	2 Click New.
	3 Enter the information for the new record.
	4 Click Update. The new record is saved.
	5 Click Close. The Test Log window is closed.
	6 In the CTT or NTT window, select Test Log from the Logs menu. The Test Log window opens.
	7 Select the new record in the table. The information about the record is shown in the Current Re...
	8 Click Close. The Test Log window is closed.
	View Tasks and Milestones


	When to use
	Related information
	To view the tasks and milestones for a Trouble Ticket:
	1 From the CTT or NTT window, select Tasks and Milestones from the View menu. The Tasks and Miles...
	2 View the information on the window.
	3 Click Close. The Tasks and Milestones window closes.
	Print a Trouble Ticket




	When to use
	Related information
	To print a trouble ticket:
	1 From the CTT or NTT window, select Print from the Work Item menu. The trouble ticket is printed...
	Pickup a Trouble Ticket

	When to use
	Related information
	To pick up a trouble ticket:
	1 From the Worklist window, select the work item for the trouble ticket.
	2 Select Pickup from the Tickets menu. Your User ID appears in the Picked Up By column and the pi...
	Drop a Trouble Ticket


	When to use
	Related information
	To drop a trouble ticket:
	1 From the Worklist window, select the work item for the trouble ticket.
	2 Select Drop from the Ticket menu. Your User ID is removed from the Picked Up By column and the ...
	Cancel a Work Item

	When to use
	Related information
	To cancel a work item:
	1 In the Worklist window, select the work item to be cancelled. then select Cancel from the Ticke...
	2 Select a cancel code from the list.
	3 Enter any comments.
	4 Click OK. The work item is cancelled and the cancellation is noted in the log.
	Complete a Task

	When to use
	Related information
	To complete a task:
	1 From the Worklist window, select the work item to be completed, then select Pickup from the Tic...
	2 Select Complete Task from the Tickets menu. The Complete Task window
	3 Enter the User ID in the Repaired by field.
	4 Select a pre-defined Cause Category.
	5 Select a Cause code.
	6 Select a pre-defined Disposition Category.
	7 Select a Disposition code.
	8 If you need to enter the Work Locations (when fields are available), select a Work Location Cat...
	9 Enter any comments in Completion Comments field.
	10 Click OK. The task is completed.
	Exit Trouble Manager





	When to use
	Related information
	To exit Trouble Manager:
	1 From the Worklist menu, select Exit from the Work Item menu. A message window opens and asks yo...
	2 Click Yes. All open system windows are closed and the program stops running on your PC or works...
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